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U n i t  2  
Entering and editing data 

Unit time: 45 Minutes 

Complete this unit, and you’ll know how to: 

A Create an Excel workbook, and enter and 
edit text and values in a worksheet.  

B Enter and edit formulas in a worksheet. 

C Insert, move, and resize pictures in a 
worksheet. 

D Save and update a workbook, and use the 
Compatibility Checker. 
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Topic A: Entering and editing text and values 
Explanation After you create a workbook, you can begin entering data in cells. Cell entries can 

include many types of data, including text and values. When you type, data is entered in 
the active cell. 

Text and values 
Text entered in cells can be any length required, and it can be formatted just as in a 
word processing program; size, font, and style can all be changed. By default, text in a 
cell is left-aligned, as shown in Exhibit 2-1. 

Values can include numbers, formulas, and functions. (Formulas and functions are 
explained in detail later.) Excel recognizes cell data as a value when it’s a number or 
when it begins with +, -, =, @, #, or $. By default, a value in a cell is right-aligned. 

 

 

 
Exhibit 2-1: A sample worksheet with text and values 

Overflowing text and values 

If a long text string doesn’t fit in a cell, it will appear to go into the next cell if that cell 
is empty. The text isn’t really in that next cell, though. If there is data in that next cell, 
the long string of text is truncated to fit the cell it’s in. 

If a long value doesn’t fit in a cell, Excel displays a row of # characters. This indicates 
that the cell is too narrow to display the value, as shown in Exhibit 2-2.  

 

 
 

The text in A1 apears to
go into adjacent cells

The formula bar shows that D1, 
the active cell, is actually empty

Values that are too long
for a cell are replaced

with a row of #s

That same text entered in
A4 is truncated by the
presence of text in B4

 
Exhibit 2-2: Text and values that are too long for their cells 
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The Num Lock key 

The numeric keypad, on the right side of most computer keyboards, is controlled by a 
Num Lock key in the upper-left corner of the keypad. Press Num Lock once to switch 
the keypad from functioning as numeric keys to functioning as navigation keys. Press 
Num Lock again to return to numbers. When numbers are active, a Num Lock light 
typically lights on the keyboard, as shown in Exhibit 2-3. 

 
 LED lit to indicate that Num Lock is active

Num Lock key

Keyboard’s numeric keypad

 
Exhibit 2-3: The Num Lock key on a keyboard’s numeric keypad 

Do it! A-1: Entering text and values 

 Here’s how Here’s why 
  1 Start Excel (Click Start and choose All Programs, Microsoft 

Office, Microsoft Office Excel 2007.) The title 
bar displays “Book1,” which is the name of the 
default workbook. 

 Click  and choose Close To close the workbook. You’ll create a new one. 

 2 Click  and choose New To open the New Workbook dialog box. Tell students they 
can also press Ctrl+N, but 
they’ll bypass the New 
Workbook dialog box.  3 Double-click Blank Workbook

 

To create a new workbook. The name of the 
new workbook, “Book2,” appears in the title 
bar. 

  4 Select B1 

 
(Click it.) To make B1 the active cell. The cell 
address B1 appears in the Name box. 
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  5 Type Outlander Spices To specify a heading for the worksheet. The text 
(or any other data) overlaps other blank cells if it 
takes up more room than the cell size allows. 
However, Excel considers the data to be the 
content of only the cell where you entered it—in 
this case, B1. 

 Press e To complete the entry and move to B2. By 
default, text entries are left-aligned. 

  6 Select A4 To make A4 active. 

 Type Month To create text that labels this column. 

 Press e To complete the entry and move to A5. 

  7 Type January To create text that labels this row. 

  8 In B4, enter Region1 The active cell now is B5. 

  9 In B5, enter 21000 

 
To enter the Region 1 sales for January. The 
workbook should look like the picture shown 
here. 
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Editing text and values 
Explanation If you make an error while entering data in a cell, you can correct it at any point. To 

make corrections, you can do any of the following: 

 
  Double-click the cell, make the corrections, and press Enter. 
  Click the formula bar, make the corrections (as shown in Exhibit 2-4), and press 

Enter. 
  Select the cell and type the correct data. 

 

 
Exhibit 2-4: The formula bar showing B1 being modified 

The Clear command 

You can use the Clear command to remove a cell’s contents, formats, comments, or all 
three. When a cell is cleared, its value is zero. To clear a cell: 

1 Activate the Home tab (if necessary). 
2 In the Editing group, click the Clear button, shown in Exhibit 2-5. 
3 Choose one of the following four options: 

  Clear All removes the cell contents, as well as any formats and comments. 
  Clear Formats removes the cell’s formats but not the contents. 
  Clear Contents removes the cell’s text or value but not the formats. 
  Clear Comments removes any comments but not the contents or formats. 

 
Editing group

Clear button

Options in the Clear button’s gallery

 
Exhibit 2-5: The options in the Clear button’s drop-down menu 

It’s easy to delete the contents of a cell without using the Clear command. Just select the 
cell and press Delete (located just above the arrow keys on most keyboards). If multiple 
cells are selected, pressing Delete will clear the contents of all of them.  



2–6 Excel 2007: Basic 

 

Do it! A-2: Editing text 

 Here’s how Here’s why 
  1 In A2, enter  

Extra sales projections 
To add text to the worksheet. 

  2 Select A2 You’ll modify the contents of this cell. 

 Select Extra in the formula bar, 
as shown   

To edit the text. 

 Type Bonus To change the text to “Bonus sales projections.” 

  3 Press n To move the insertion point to the end of the 
text, where you’ll add more text. 

 Press q To add a space before the new text. 

 Type for the northern 
region 

To add this text. 

 Press e The text now reads “Bonus sales projections for 
the northern region.” 

  4 Enter Final Version in A3  Type “Final Version” and press Enter.  

  5 Enter Confidential in C3  

  6 Select A3 You’ll remove the text from A3 and C3. 

 Press c and select C3 

 
Holding the Ctrl key while you click the mouse 
causes both cells to be selected. The outline box 
surrounds the current cell. Any other cells that 
have been selected are shaded. 

  7 Press j 

 
Only the contents of the current cell are cleared. 
The text in the other selected cell remains. 

 Press g To undo the Backspace action and restore the 
contents of C3. 
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  8 Click  (The Clear button is in the Editing group.) To 
display the Clear menu. 

Tell students that they can 
also press Delete. 

Choose Clear All To clear both contents and formats from the 
selected cells.  
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AutoFill 
Explanation When you need to enter a list of numbers, dates, days of the week, or other sequential 

data, you can use the AutoFill feature to complete the list, as shown in Exhibit 2-6.  

The fill handle is a small square in the lower-right corner of a selected cell or range. 
When you point to the fill handle, the pointer changes to a plus sign (+). The fill handle 
can autofill a range to complete a list or series. 

To use AutoFill: 
1 Select the cell containing the value that starts the list or series. 
2 Point to the fill handle until the pointer changes to a + symbol. 
3 Drag the fill handle over the adjacent cells that you want to fill. 

For numbers or dates, you can select two cells with a desired range, and AutoFill will 
continue with the same increments. For example, you could use this technique to fill a 
range by 10s or to fill a range with dates a week apart.  

 

 

 
Exhibit 2-6: Using AutoFill to insert a list of months 
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Do it! A-3: Using AutoFill to fill a series 

 Here’s how Here’s why 
  1 Select B4 It contains the text “Region1.” You’ll use 

AutoFill to add more headings. 

  2 Point to the fill handle, as shown 
 

The pointer takes the shape of a plus sign (+).  

  3 Press and hold the mouse button  

 Drag the fill handle to the right to 
E4, as shown 

 
As you drag, a shaded outline appears around 
the range you’re filling. As you drag past each 
cell, a screen tip displays what will be entered in 
each cell. 

 Release the mouse button To finish autofilling the cells for the remaining 
regions. 

  4 Select A5 You’ll autofill the remaining months in the year. 

 Autofill to cell A16 (Drag the fill handle to A16.) The cells are 
populated with the months of the year, as shown 
in Exhibit 2-6. 

  5 Click  and choose Close To close the workbook. A message box appears, 
prompting you to save the workbook. 

  6 Click No To close the workbook without saving it. 
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Topic B: Entering and editing formulas 
Explanation 

 

Formulas perform numeric calculations, such as adding, multiplying, and averaging. All 
formulas in Excel begin with the equal sign (=). A formula can refer to a value, a cell 
address, or another formula. Functions are predefined formulas that perform string 
operations or calculations, which can be simple or complex. Many formulas contain 
operators—characters that indicate the type of arithmetic operation the formula will 
perform. 

The following table shows the types of arithmetic operators you can use: 
 

Operator Used for… Example 
 

+ Addition =A7+A9 

 - Subtraction =A7-A9 

 * Multiplication =A7*A9 

 / Division =A7/A9 

 % Percentages =50% 

 ^ Exponents =5^3 means 5 raised to the third power (53), or 5*5*5 

 

Entering formulas 

 To enter a formula, select the cell where you want the result to appear. Then type the 
formula and press Enter. For example, if there are numbers in A2 and A3, and you want 
to add them and show the result in A4, you select A4, type =A2+A3, and press Enter. 
The result appears in A4. If A4 is the active cell, the formula appears in the formula bar 
(as shown in Exhibit 2-7). 

Formulas are based on the values contained in the cells in your worksheet. If you 
change the cells that a formula refers to, the result of the formula will change. 

 

 

Exhibit 2-7: A sample formula, showing the result in the active cell and the formula in 
the formula bar 
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Do it! B-1: Entering a formula by typing 

 Here’s how Here’s why 
  1 Open Sales Click the Office Button and choose Open. 

Navigate to the current unit folder, and double-
click Sales in the Open dialog box.  

  2 Select G5 To activate the cell where you’ll enter a formula. 

Type = To indicate that you’re about to enter a formula 
rather than text or a value.  Tell students not to 

press Enter after typing 
the equal sign. 

 3 Type C5+D5+E5+F5 This formula adds the values of the quarterly 
bonus sales for Kendra James; these values are 
in cells C5 through F5. 

 Press e The result of the formula is $23,442.00. 

  4 Select G5 
 

The formula bar shows the formula, not the 
result. 

  5 Select F5 You’ll change one of the cells in the formula.  

Type 1000  Tell students that the 
decimal will automatically 
be placed correctly. Press e The result of the formula in G5 automatically 

changes to $16,158.00. 
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Using the mouse to enter cell references in formulas 
Explanation You can use the mouse to enter cell references for a formula. To do so: 

 

 

1 Select the cell where you want to enter the formula. 
2 Type = (to begin a formula). 
3 Click the cell for which you want to enter a reference. 
4 Type the operator you want. 
5 Repeat Steps 3 and 4 until you’ve created the formula you want. 
6 Press Enter. 

Do it! B-2: Entering cell references with the mouse 

 Here’s how Here’s why 
  1 Select G6 You’ll enter a formula to calculate the total 

quarterly bonus sales for Pamela Carter.  

 Type = To begin the formula. 

  2 Select C6 To enter this cell’s address in the formula you’re 
creating. 

 Type + To continue to build the formula. 

  3 Select D6 To enter D6 in the formula.  

  4 Complete the formula as shown, 
using the mouse to enter the cells  

 Press e To enter the formula. G6 now contains the total 
quarterly bonus sales for Pamela Carter. G9 
contains $40,913.00, which is the total of the 
values in G5 and G6. 

  5 In G7, enter a formula to calculate 
the total bonus sales for Julie 
George 

Use any method you like. When you are 
finished, G7 should contain $23,765.  
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Editing formulas 
Explanation Formulas can be edited to adapt to changes in the worksheet or to correct a mistake. 

Edit a formula as you would edit any other cell. Simply double-click the cell and enter 
the correct formula. You can also edit a formula by using the formula bar: 

1 Select the cell containing the formula. 
2 Edit the formula in the formula bar. 
3 Press Enter. 

Do it! B-3: Editing a formula 

 Here’s how Here’s why 
  1 Observe G9 The total displayed in this cell is incorrect. 

  2 Select G9 You’ll edit the formula in this cell. 

 Observe the formula bar The formula bar shows =G5+G6. This formula 
doesn’t include the total for Julie George.  

  3 Place the insertion point at the end 
of the formula  

  4 Type+G7 To add the G7 cell value to the formula. 

 Press e  

  5 Observe G9 G9 now shows the correct value, $64,678.00. 
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Topic C: Working with pictures 
This topic covers the following Microsoft Certified Applications Specialist exam 
objective for Excel 2007. 

 
 # Objective 

 4.4.1 Insert and modify pictures from files 

  Insert pictures 

  Modify pictures 

 

Using pictures in worksheets 
Explanation You can insert pictures and other graphics files to illustrate and enhance worksheets and 

printed reports, as shown in Exhibit 2-8. Excel supports dozens of industry-standard 
picture file formats, including .bmp, .jpg, .eps, and .tif. 

 

 

 
Exhibit 2-8: A worksheet with a picture 

Adding pictures 

To place a picture in a worksheet: 

 
Objective 4.4.1 

1 Activate the Insert tab. 
2 In the Illustrations group, click the Insert Picture From File button. The Insert 

Picture dialog box appears. 
3 Navigate to the picture’s location, select the file, and click Insert. The picture 

appears in the worksheet, and the Picture Tools tab is activated. 
4 Use the tools on the Picture Tools tab to modify the picture as necessary. 
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Moving pictures 

When you insert a picture into a worksheet, Excel places it in the approximate middle of 
your screen. You can move a picture so that it appears and prints in a specific place in a 
worksheet. To move a picture: 

1 Point anywhere within the picture. The pointer changes to a four-headed arrow. 
2 Drag the picture. As you drag, the picture remains stationary, but a shadow of it 

moves with the pointer, as shown in Exhibit 2-9. 
3 Position the outline box where you want the picture to be. 
4 Release the mouse button. The picture moves to the location of the outline box. 

 

 
Exhibit 2-9: A gray outline box indicates where the picture will be moved to  

Resizing pictures 

There are several ways to resize a picture: 
Objective 4.4.1   Select the picture; this activates the Picture Tools tab. In the Size group, enter 

new values in the Height and Width boxes. 
  In the Size group, click the Dialog Box Launcher button (in the lower-right 

corner of the group). The Size and Properties dialog box appears with the Size 
tab activated. Under Size and Rotate, or under Scale, resize the picture. 

  Point to one of the sizing handles at the corners of the picture frame. The pointer 
changes to a double-headed arrow. Drag a sizing handle to resize the picture. 

To resize a picture proportionally, click and hold Shift before dragging the sizing 
handles. This forces the picture’s height and width to resize at the same rate.  
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Do it! C-1: Inserting and modifying a picture 

 Here’s how Here’s why 
Objective 4.4.1  1 Activate the Insert tab You’ll insert a logo picture in this worksheet. 

  2 Click  (The Insert Picture From File button is in the 
Illustrations group.) The Insert Picture dialog 
box appears.  

Navigate to the current unit folder  Help students navigate to 
the correct folder. 

Select logo From the current unit folder. 

Tell students they can 
also double-click the file to 
insert it. 

Click Insert To insert the picture. The logo appears in the 
middle of the worksheet, and the Picture Tools 
tab is activated. 

  3 In the Size group, observe the 
picture dimensions 

 
The picture is 0.49 inches tall and 3.02 inches 
wide. 

  4 Point to the handle in the lower-
right corner of the picture, as 
shown 

 
The pointer changes to a double-headed arrow. 

 Press and hold s  

 Drag up and to the left slightly To proportionally resize the picture. 

  5 Observe the picture dimensions In the Size group. 

Tell students that the 
picture size does not need 
to be exact. 

Resize the picture proportionally 
until it is approximately the height 
of three rows 

 
Press Shift and drag the picture handle in or out 
to get the desired size. 
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  6 Point anywhere inside the picture The pointer changes to a four-headed arrow. 

 Drag up and to the left A shadow of the picture moves with the pointer.  

 Move the upper-left corner of the 
outline box to the upper-left 
corner of B1 

Where the words “Outlander Spices” appear. 

  7 Click anywhere in the worksheet To deselect the picture. The worksheet should 
resemble Exhibit 2-8. 
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Topic D: Saving and updating workbooks 
This topic covers the following Microsoft Certified Applications Specialist exam 
objective for Excel 2007. 

 
 # Objective 

 5.4.1 Save workbooks for use in a previous version of Excel 

  Using Compatibility Checker, determine which feature of a workbook is incompatible with a 
previous version 

  Save a specific feature to the Excel 97-2003 format 

 

Saving workbooks 
Explanation Saving a workbook stores your data for future use. Every time you change anything in a 

worksheet, you’ll need to save the worksheet (update it) if you want to keep your 
changes.  

Saving a file for the first time 

The first time you save a workbook, you need to assign a file name and location for the 
file. You must also choose a file format. Some typical file formats include: 

 
 Format Extension Description 

 Microsoft Excel Workbook .xlsx This is the default workbook format for Excel 
2007. 

 XML Data .xml The XML format is useful for data that must be 
transferred between applications.  

 Text .txt Files saved in plain text format can be opened 
by any word processor or text editor.  

 Comma Separated Values .csv Data fields in a CSV file are delimited by 
commas.  

 Excel 97 - Excel 2003 
Workbook 

.xls This is the workbook format that can be opened 
by earlier versions of Excel.  

 Web Page .html This format enables the workbook to be 
published as a Web page. 
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To save a workbook for the first time: 

 
1 Click the Office Button and choose Save, or click the Save button on the Quick 

Access toolbar. The Save As dialog box opens (as shown in Exhibit 2-10) 
because this file does not yet have a file name. 

2 From the Save in list, select the drive and folder where you want to save the 
workbook. 

3 In the File name box, enter a name for the workbook. 
4 From the Save as type list, select the file format in which you want to save the 

workbook. 
5 Click Save. 

Creating folders 

If you don’t want to save your workbook in an existing folder, use the Save As dialog 
box to create a new folder. Here’s how: 

1 From the Save in list, select the location where you want to create the folder. 
2 In the Save As dialog box, click the Create New Folder button to open the New 

Folder dialog box. 
3 In the Name box of the New Folder dialog box, type a name for the folder. 
4 Click OK. The new folder appears in the Save in list. 

 

 
 Create New Folder

 
Exhibit 2-10: The Save As dialog box 
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Do it! D-1: Saving a workbook 

 Here’s how Here’s why 

 1 Open a new blank workbook Click the Office Button and choose New, or 
press Ctrl+N. 

Explain that you can open 
one file “on top of” another 
file, without closing the 
previous file.  2 Click  (The Save button is on the Quick Access 

toolbar, near the top-left corner of the 
workbook.) To save the workbook.  

 Observe the Save in box The last folder you accessed is active and, unless 
changed, will be the location for your file. You 
can select various special folders from the left 
side of the dialog box. 

 In the File name box, enter  
My saved file 

 

Click Save To save the file with the name and location you 
specified. Tell students they 

can also press Enter after 
typing the file name. 

 3 Observe the title bar 
 

The new file name is displayed. 

Click  (The Close button is in the upper-right corner of 
the file window.) To close the file. Guide students to 

click the bottom X to close 
the file, not the top X. 

 4 Click  and choose Save As To open the Save As dialog box. You’ll save the 
Sales file with a different name and in a 
different location. 

Tell students they can 
also press Alt+4. 

 5 Click  (The Create New Folder button is on the toolbar 
in the Save As dialog box.) To open the New 
Folder dialog box. 

 In the Name box, type  
My folder 

To name the new folder. 

 Click OK 
 

The name of the folder you created appears in 
the Save in box. 

  6 In the File name box, type  
My Sales 

This is the new name for the file. 

 Click Save To save the file. 

  7 Observe the title bar It displays the workbook’s name. 
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Updating workbooks 
Explanation Each time you save a workbook, Microsoft Excel updates the workbook file with the 

latest changes. You should update your workbooks frequently so that changes aren’t 
lost. To save changes in a workbook, click the Save button on the Quick Access toolbar 
or press Ctrl+S. 

Do it! D-2: Changing and updating a workbook 

 Here’s how Here’s why 
  1 In A10, enter Annual target To add text to the worksheet. 

  2 Click  To update the workbook with the newly added 
text.  

  3 Open the Save As dialog box (Click the Office Button and choose Save As.) 
You’ll save a copy of the workbook with a 
different name. 

  4 In the File name box, type  
My annual target 

To specify a different name for the workbook. 

 Click Save To save the workbook. 

  5 Observe the title bar The name of the current workbook, “Annual 
target,” now appears in the title bar. 

  6 Close the workbook Click the Office Button and choose Close. 
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Previous versions of Excel 
Explanation Workbooks created in Excel 2007 are not compatible with previous versions of Excel. 

You can, however, save a workbook created in Excel 2007 as an Excel 97-2003 
workbook to enable people with earlier versions to open and use it. 

To save a workbook in the Excel 97-2003 Workbook format, click the Office Button 
and choose Save As, Excel 97-2003 Workbook. The Save As dialog box opens, with 
Excel 97-2003 Workbook selected in the “Save as file type” box. Enter a name for the 
workbook, if necessary, and click Save. In the Save as type list, select Excel 97-2003 
Workbook. 

The Compatibility Checker 

Not all features present in Excel 2007 workbooks can be saved in the 97-2003 
workbook format. You can check which features are incompatible with earlier versions 
of Excel by running the Compatibility Checker, shown in Exhibit 2-11. 

Objective 5.4.1 There are two way to use the Compatibility Checker to determine which Excel 2007 
features are incompatible with earlier versions of Excel:  

  Click the Office Button and choose Prepare, Run Compatibility Checker.  
  Click the Office Button and choose Save As, Excel 97-2003 Workbook to open 

the Save As dialog box. Click Save. If the workbook has any features that cannot 
be saved in the file format for the earlier version of Excel, the Compatibility 
Checker will launch, notifying you of any problems. 

If it’s possible to correct the feature, the Compatibility Checker will display the Fix 
option. You can choose whether to fix the issue or leave it as is. If you leave the feature 
as is, however, it will not be displayed properly when the workbook is opened in the 
earlier version of Excel. 

You can configure the Compatibility Checker to run automatically whenever you update 
the workbook. Just check “Check compatibility when saving this workbook” in the 
Compatibility Checker dialog box. 

 

 
Exhibit 2-11: The Compatibility Checker 
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Do it! D-3: Using the Compatibility Checker 

 Here’s how Here’s why 
Help students navigate to 
the current unit folder. 

 1 Open 97 Sales In the current unit folder. You’ll save this 
workbook in the Excel 97-2003 Workbook 
format. 

  2 Observe the worksheet The header contains the current date and the 
word “Confidential” formatted in blue. 

  3 Click   

Objective 5.4.1 Choose Prepare,  
Run Compatibility Checker 

To open the Microsoft Office Excel - 
Compatibility Checker dialog box. A message 
appears, stating that color formatting in header 
and footer text is not supported in previous 
versions of Excel. 

  4 Click Fix To change the header text to black and correct 
the incompatibility. 

  5 Click OK To close the dialog box and apply the change. 
The text is reformatted.  

 Click   

Objective 5.4.1 Choose Save As,  
Excel 97-2003 Workbook 

To open the Save As dialog box. Excel 97-2003 
Workbook is selected in the Save as type list. 

  6 Edit the file name to read  
My 97 Sales 

 

 Click Save To save the file in the new format with a new 
name. 

 Close the workbook  
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Unit summary: Entering and editing data  
Topic A In this topic, you created a workbook and learned how to enter and edit text and values 

in a worksheet. You learned that, by default, text is left-aligned and values are right-
aligned. You also learned how to edit a cell by clicking the formula bar and by double-
clicking a cell. Then, you learned how to autofill a series. 

Topic B In this topic, you learned how to use formulas to perform calculations on values in a 
worksheet. You learned how to enter formulas and how to use an operator to combine 
values. You also learned how to use the mouse to enter cell references and how to edit 
formulas. 

Topic C In this topic, you learned how to insert a picture into a worksheet. You also learned how 
to resize a picture proportionally and how to move a picture in the worksheet. 

Topic D In this topic, you learned how to save and update a workbook to prevent data loss. In 
addition, you learned how to save a file with a different name and in a different location. 
Finally, you learned how to save workbooks in an earlier version of Excel, and how to 
run the Compatibility Checker to find features that might not be compatible with 
earlier versions. 

Independent practice activity 
In this activity, you’ll create a workbook, enter data, create formulas, and save the 
workbook in both 2007 and 97-2003 formats.  

 1 Create a new workbook. 

 2 Enter data beginning in row 4, as shown in Exhibit 2-12. 

 3 In column E, enter formulas to calculate the total costs for each item. (Hint: The 
multiplication operator is *.) Compare your results to Exhibit 2-13. 

 4 Insert the picture file Outlander into the worksheet. 

 5 Resize the picture and position it as shown in Exhibit 2-13. (Hint: Resize the picture 
proportionally until it is approximately 1.65 inches wide.) 

 6 Save the workbook as My total costs in the current unit folder. 

 7 Save the workbook as an Excel 97-2003 Workbook, with the name My total costs 
97. 

 8 Close the workbook. 
 

 
Exhibit 2-12: The data to be entered in Step 2 
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Exhibit 2-13: The formula results after Step 4  

Review questions 
 1 Name two basic types of data that can be entered in a worksheet. 

You can enter text or values. Values can be numbers, formulas, or functions.  

 2 How can you clear a cell’s text or value but not its formatting? 

On the Home tab, in the Editing group, click the Clear button and choose Clear Contents. 

 3 All formulas must begin with what symbol? 

All formulas begin with the equal sign (=). 

 4 How do you resize a picture so that its dimensions remain proportional? 

Press Shift and drag one of the resizing handles on the picture. 

 5 What is the default file-name extension for workbooks saved in Excel 2007? 

The default workbook file-name extension is .xlsx. 
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